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ArcGIS Data Appliance: Esri Vector Basemaps

What is ArcGIS Data Appliance: Esri Vector Basemaps?

Esri Vector Basemaps provides detailed maps from industry-leading data providers that you can use with your
ArcGIS and web applications. Vector tiles enable dynamic cartography and provide the flexibility to create your own
basemap style. The vector basemaps are available as tile layers that can be added to existing maps as either a
basemap or an overlay layer.

Esri Vector Basemaps provides a content solution that works with ArcGIS Enterprise. It is included (shipped
separately) with ArcGIS Data Appliance 2022 with World Standard, World Advanced, North America Standard, and
North America Advanced product options. It can also be licensed as a stand-alone option.

I Note:
This feature is not included with the World Basic product option.

The Esri Vector Basemaps help includes the following topics:
« Esri Vector Basemaps content

+ Directory of map styles

+ System requirements

+ Set up Esri Vector Basemaps

« Information on how to use Esri Vector Basemaps

* Methods to customize and localize Esri Vector Basemap styles

- Reference information including FAQs, Troubleshooting, and Support

Copyright © 1995-2021 Esri. All rights reserved. 4
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Esri Vector Basemaps content

Esri Vector Basemaps is delivered on a USB flash drive loaded with two vector tile packages, styles, and style
publishing toolboxes (.tbx file).

I Note:
Esri Vector Basemaps ships separately.

This version includes the following:

« Installation vector tile packages that you upload to your ArcGIS Enterprise portal using ArcGIS Pro and publish as
a hosted vector tile service on your hosting server:
= Esri_Vector_Basemap_DA2022_Install.vtpk—A vector tile package for customers who want to use Web

Mercator Auxiliary Sphere (WMA).

= Esri_Vector_Basemap_GCS_DA2022_Install.vtpk—A vector tile package for customers who want to use
Esri Vector Basemaps in WGS84 Geographic (GCS). This . vtpk file uses the WGS84 Geographic, version 2 tiling
scheme.

« Map styles (for each projection) that you publish as vector tile layers to your Enterprise portal to use in your maps
and apps or customize. These styles require resources included in the VectorBasemapStyles folder for publishing.

« Vector Style publishing tools for managing your vector basemap tile layers (map styles) in your Enterprise portal:
* VectorStylePublisher.tbx—This toolbox is used to create vector basemap tile layers.

= VectorStyleUpdater.tbx—This toolbox is used to update existing vector basemap tile layers.

» Map style text files to help you with map style updates:
= DA2022_WMA_StyleUpdater_template.csv—This file manages WMA styles.

= DA2022_GCS_StyleUpdater_template.csv—This file manages GCS styles.

« Documentation file (data_appliance_esri_vector_basemaps.pdf) that includes instructions for getting
started, setup, using Esri Vector Basemaps, and more.

I Note:

Do not use the Esri_Vector_Basemap_DA2022_Install and Esri_Vector_Basemap_GCS_DA2022_Install vector tile
packages for anything other than publishing the tile layer (hosted). Once you publish the tile layer to your
Enterprise portal, do not share the .vtpk files publicly (Everyone), as distribution of these items outside of your

organization is not permitted.
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What's new

This update of ArcGIS Data Appliance: Esri Vector Basemaps contains two updated vector tile packages (. vtpk files)

used to publish as hosted vector tile services in your ArcGIS Enterprise portal. One is in the Web Mercator Auxiliary
Sphere (WMA) projection and the other is in the WGS84/GCS (GCS) tiling scheme. Map styles can be published as
vector tile layers for each option.

These vector tile packages contain updated global data from a variety of sources including HERE and
OpenStreetMap, as well as local authoritative data from the Esri Community Maps Program.

There is one new map style, Outline, and 34 of the Esri Vector Basemaps vector tile layers (map styles) include
cartographic styling refinements.

Existing users of the vector basemaps in ArcGIS Data Appliance can update the hosted tile layer as well as add the
new style and update 34 of the 50 styles from version 7.2. The VectorStyleUpdater toolbox uses a template of
existing item IDs and can be run in ArcGIS Pro.

New users can publish any or all of the full set of 51 styles.

Copyright © 1995-2021 Esri. All rights reserved. 6
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Directory of map styles

Esri Vector Basemaps includes the following 51 vector tile layers. The styles can be published in Web Mercator
Auxiliary Sphere (WMA) projection or WGS84/GCS (GCS) tiling scheme.

Layer name and

thumbnail Style folder name
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Description

The Charted Territory vector tile layer
provides a detailed basemap featuring a
geopolitical style reminiscent of a printed
atlas plate or a school classroom wall map.
This layer is designed for use with the World
Hillshade basemap.

The Colored Pencil vector tile layer is
presented in the style of hand-drawn, colored
pencil cartography.

The Community vector tile layer provides a
detailed basemap featuring strong colors to
emphasize large scale features.

The Dark Gray Canvas vector tile layer
provides a detailed basemap of the world
featuring a dark neutral background style
with minimal colors, labels, and features.

The Dark Gray Canvas (Community Maps)
vector tile layer provides a detailed basemap
featuring a dark neutral background style
with minimal colors, labels, and features with
select roads provided by community
contributors.
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Layer name and

thumbnail Style folder name
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Description

The Dark Gray Canvas Base vector tile layer
provides a detailed basemap of the world
featuring a dark neutral background style
with minimal colors, labels, and features. This
layer is designed for use with the Dark Gray
Canvas Reference layer.

The Dark Gray Canvas Reference vector tile
layer provides a city reference overlay of the
world designed for use over a dark neutral
background style with minimal colors, labels,
and features. This layer is designed for use
with the Dark Gray Canvas Base layer.

The Dark Gray Canvas Reference (Local
Language) vector tile layer provides a
detailed reference label layer. Labels are in
local languages at large scale. This layer is
designed for use with the Dark Gray Canvas
Base layer.

The Human Geography Base vector tile layer
provides a detailed vector basemap of the
world symbolizing the land with a light gray,
neutral background style.

The Human Geography Dark Base vector tile
layer provides a simple vector basemap of
the world symbolizing the land with a very
dark gray, neutral background style.
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Layer name and
thumbnail

Human Geography Dark
Detail
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Label
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Style folder name
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Description

The Human Geography Dark Detail vector tile
layer provides a detailed basemap with a dark
monochromatic style and content adjusted to
support human geography information. This
layer is a detailed reference layer that
includes administrative boundaries, roads,
and highways.

The Human Geography Dark Label vector tile
layer provides a detailed basemap with a dark
monochromatic style and content adjusted to
support human geography information. The
map includes labels for highways, major
roads, minor roads, water features, cities,
landmarks, and administrative boundaries.

The Human Geography Detail vector tile layer
provides a detailed basemap with a
monochromatic style and content adjusted to
support human geography information.

The Human Geography Label vector tile layer
provides a detailed vector basemap for world
labels designed to draw attention to the
thematic content.

The Hybrid Reference Layer vector tile layer
provides a detailed reference layer of the
world designed to be overlaid on imagery.
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Layer name and

thumbnail Style folder name
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Description

The Hybrid Reference Layer (Community
Maps) vector tile layer provides a detailed
reference layer of the world designed to be
overlaid on imagery with select roads
provided by community contributors.

The Hybrid Reference Layer (Local Language)
vector tile layer provides a detailed reference
layer, including transportation and labels of
the world. Labels are in local languages at
large scale. This layer is designed for use with
the World Imagery basemap.

The Light Gray Canvas vector tile layer
provides a detailed vector basemap of the
world symbolized with a light gray, neutral
background style with minimal colors, labels,
and features that is designed to draw
attention to the thematic content.

The Light Gray Canvas (Community Maps)
vector tile layer provides a detailed basemap
featuring a light neutral background style
with minimal colors, labels, and features.
Select roads are provided by community
contributors.

The Light Gray Canvas Base vector tile layer
provides a detailed basemap of the world
featuring a light neutral background style
with minimal colors, labels, and features. This
layer is designed for use with the Light Gray
Canvas Reference layer.
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Layer name and
thumbnail
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Description

The Light Gray Canvas Reference vector tile
layer provides a detailed reference overlay of
the world featuring a light neutral
background style with minimal colors, labels,
and features. This layer is designed for use
with the Light Gray Canvas Base layer.

The Light Gray Canvas Reference (Local
Language) vector tile layer provides a
detailed reference label layer. Labels are in
local languages at large scale. This layer is
designed for use with the Light Gray Canvas
Base layer.

The Mid-Century vector tile layer provides a
customized vector layer of the world
symbolized with a unique mid-century styled
map. It takes its inspiration from the art and
advertising of the 1950s with unique fonts.
The symbols for cities and capitals have an
atomic slant to them.

The Modern Antique vector tile layer provides
a customized vector layer of the world
symbolized with a unique antique-styled map
and a modern flair—including the benefit of
multiscale mapping.

The National Geographic Style vector tile
layer provides a detailed basemap featuring
boundary ribbons and other map content.
This layer is designed for use with the World
Hillshade relief basemap for added context.
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Layer name and

thumbnail Style folder name

National Geographic
Style (Local Language)

vvvvvvv

k - il - natgeostylelocallanguage

Newspaper
Malden © *
el
Jialtham newspaper
it

Jiewiom

Nova

nova
Outline

outline
World Navigation Map

navigation

World Navigation Map
(Community Maps)

navigationcommunity
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Description

The National Geographic Style (Local
Language) vector tile layer provides a
detailed basemap featuring boundary ribbons
and other map content. This layer is designed
for use with the World Hillshade relief
basemap for added context. Labels are in
local languages at large scale.

The Newspaper vector tile layer provides a
customized vector layer of the world
symbolized with a unique newspaper-styled
map. It has a black and white appearance
with select features highlighted in red. Many
of the area fills have halftone patterns
commonly found in traditional newspaper
printing.

The Nova vector tile layer provides a detailed
basemap of the world featuring a dark
background with glowing blue symbology
inspired by the ArcGIS.com splash screen. The
Nova vector tile layer emulates this color
scheme with a grid pattern across the ocean
and stripes or square stippled patterns for
land use features visible at larger scales.

The Outline vector tile layer provides a
detailed basemap of the world featuring a
simple black and white outline.

The World Navigation Map vector tile layer
provides a detailed basemap of the world
featuring a custom navigation map style.

The World Navigation Map (Community
Maps) vector tile layer provides a detailed
basemap of the world featuring a custom
navigation map style with select roads
provided by community contributors.
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Layer name and

thumbnail Style folder name
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navigationdarklocallanguage

Description

The World Navigation Map (Local Language)
vector tile layer provides a detailed basemap
of the world featuring a custom navigation
map style. Labels are in local languages at
large scale.

The World Navigation Map (Dark Mode)
vector tile layer provides a detailed basemap
featuring a dark navigation map style.

The World Navigation Map (Dark Mode -
Community Maps) vector tile layer provides a
detailed basemap featuring a dark navigation
map style with select roads provided by
community contributors.

The World Navigation Map (Dark Mode -
Local language) vector tile layer provides a
detailed basemap featuring a dark navigation
map style. Labels are in local languages at
large scale.

The World Ocean Reference vector tile layer
provides a detailed basemap featuring a
custom ocean style. This layer is designed for
use with the World Ocean Base raster layer.
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Layer name and
thumbnail
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Description

The World Street Map vector tile layer
provides a detailed basemap of the world
featuring a classic Esri street map style.

The World Street Map (Community Maps)
vector tile layer provides a detailed basemap
of the world featuring a classic Esri street map
style with select roads provided by
community contributors.

The World Street Map (Local Language)
vector tile layer provides a detailed basemap
of the world featuring a classic Esri street map
style. Labels are in local languages at large
scale.

The World Street Map (Night) vector tile layer
provides a detailed basemap of the world
featuring a custom nighttime street map
style.

The World Street Map (Night - Community
Map) vector tile layer provides a detailed
basemap of the world featuring a custom
nighttime street map style with select roads
provided by community contributors.
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Layer name and
thumbnail
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Description

The World Street Map (Night-Local
Language) vector tile layer provides a
detailed basemap of the world featuring a
custom nighttime street map style. Labels are
in local languages at large scale.

The World Street Map (with Relief) vector tile
layer provides a detailed basemap of the
world featuring a classic Esri street map style
designed for use with a relief map.

The World Street Map (with Relief -
Community Maps) vector tile layer provides a
detailed basemap of the world featuring a
classic Esri street map style designed for use
with a relief map. Select roads are provided
by community contributors.

The World Terrain Base vector tile layer
displays minimal map content: water and land
fill, water lines, and roads. This layer is
designed for use as a base layer with the
World Terrain Reference layer and World
Hillshade basemap.

The World Terrain Reference vector tile layer
displays minimal map content: populated
place names, administrative areas, and water
labels with boundary lines. This layer is
designed for use as a reference overlay with
the World Terrain Base layer and the World
Hillshade basemap.

15



ArcGIS Data Appliance: Esri Vector Basemaps

Layer name and
thumbnail
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Description

The World Terrain Reference (Local
Language) vector tile layer provides a
detailed reference layer of the world. Labels

are in local languages at large scale. This layer

is designed for use with the World Terrain

Base layer and the World Hillshade basemap.

The World Terrain with Labels vector tile layer

provides a detailed basemap of the world
symbolized with populated places,
administrative areas, boundary lines, and
roads. The minimal features and styling are
designed to draw attention to the thematic
content.

The World Terrain with Labels (Community
Maps) vector tile layer provides a detailed
basemap of the world symbolized with
populated places, administrative areas,
boundary lines, and roads. The minimal
features and styling are designed to draw
attention to the thematic content. Select
roads are provided by community
contributors.

The World Topographic Map vector tile layer

provides a detailed basemap of the world

featuring a classic Esri topographic map style

designed for use with a relief map.

The World Topographic Map (Local
Language) vector tile layer provides a
detailed basemap of the world featuring a
classic Esri topographic map style. Labels are
in local languages at large scale. This layer is
designed for use with the World Hillshade
basemap.
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Frequently asked questions

Listed below are frequently asked questions and answers regarding ArcGIS Data Appliance: Esri Vector Basemaps.
» How does ArcGIS Data Appliance: Esri Vector Basemaps work?

* How do | set up Esri Vector Basemaps?

* Where does the data come from?

+ Does Esri Vector Basemaps include imagery?

» What services are available?

+ Are there any use restrictions when using Esri Vector Basemaps?

» Where can | find more information about editing custom styles?

» Where can | find more information about using basemaps in my Portal for ArcGIS Map Viewer Classic?

» What if | need further assistance?

How does ArcGIS Data Appliance: Esri Vector Basemaps work?

ArcGIS Data Appliance: Esri Vector Basemaps is published as a hosted vector tile service from your Enterprise portal
along with several dozen map styles that you can share, use, and customize within your organization. For more
information on vector basemaps and the differences between raster and vector tile layers, see Tile layers in the
Portal for ArcGlIS help.

How do | set up Esri Vector Basemaps?

Refer to the instructional video and help documentation on the Esri Vector Basemaps Additional resources section
of the ArcGIS Data Appliance 2022 website to learn how to set up and use Esri Vector Basemaps.

Where does the data come from?

The content used with Esri Vector Basemaps is the same content you see online for Esri Vector Basemaps. The data
sources are included as part of the Credits in the map styles you publish to your portal.

Does Esri Vector Basemaps include imagery?

No. Esri Vector Basemaps does not include raster basemaps or imagery.

What services are available?

Esri Vector Basemaps only requires one service published as a hosted vector tile layer from your portal. Other maps
are included as map styles that you publish to your portal as tile layers. See Directory of map styles for the vector
tile layers included with Esri Vector Basemaps.

Copyright © 1995-2021 Esri. All rights reserved. 17
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ArcGIS Data Appliance: Esri Vector Basemaps

Are there any use restrictions when using Esri Vector Basemaps?

The data is provided by multiple third-party data vendors under license to Esri for inclusion in ArcGIS Data
Appliance for use with Esri software. Redistribution rights are granted by Esri and the data vendor for hard-copy
renditions or static, electronic map images (for example, .gif and . jpeg files) that are plotted, printed, or publicly
displayed with proper metadata and source or copyright attribution to the respective data vendor or vendors. For
copyright and attribution information, see Credits for a specific map published to your portal.

Where can | find more information about editing custom styles?

View the Working with and Customizing Esri Vector Basemaps: The Basics post on the ArcGIS Blog website for more
information about editing custom styles.

Where can | find more information about using basemaps in my Portal for ArcGIS Map Viewer Classic?
See Customize basemaps and Choose basemap in the Portal for ArcGIS help for more information about using

basemaps in your Portal for ArcGIS Map Viewer Classic.

What if | need further assistance?

For all questions, feedback, and troubleshooting, and to report issues, contact Esri Technical Support.

Copyright © 1995-2021 Esri. All rights reserved. 18
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System requirements

Copyright © 1995-2021 Esri. All rights reserved.
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Esri Vector Basemaps system requirements
The following software components and prerequisites are required before you deploy Esri Vector Basemaps:
« ArcGIS Pro Basic, Standard, or Advanced 2.8 or later.

« An ArcGIS Enterprise 10.7.1, 10.8, 10.8.1, or 10.9 deployment meeting the base ArcGIS Enterprise deployment
specifications.

I Note:
Authentication exclusions—The Linux public key infrastructure (PKI) configuration is not supported.

Before you start
Before you begin your deployment, do the following:

1. Check with your portal administrator to verify or request the following:
+ A Portal for ArcGIS account with the Publisher or Administrative role enabled.

« A named user license enabled for ArcGIS Pro Standard or Advanced.

« A minimum of 70 GB of available space per .vtpk file for your portal content directory, 35 GB of available
space for your hosting server’s jobs directory, and 35 GB of available space for your hosting server’s cache
directory.

2. Check with your ArcGIS Server administrator to verify or request the following:
« A minimum of 70 GB of available disk space per .vtpk file on your ArcGIS Server.

 Enough pooling time for your ArcGIS Server. Successfully publishing a large .vtpk file as a hosted vector tile

service requires more time for the web client to communicate with ArcGIS Server. Check with your ArcGIS
Server administrator to confirm that the The maximum time a client can use a service option is set to
21,600 seconds.

The following steps walk you through this process for ArcGIS Server 10.7.1, 10.8, 10.8.1, or 10.9:

+ Open a new browser and access ArcGIS Server Manager, for example, https://PORTALNAME/server/
manager, and sign in.

+ Click Site (root) > System > PublishingTools.

« Click Pooling, and under Specify Service Timeouts, change the value for The maximum time a client
can use a service from 3,600 seconds (1 hour) to 21600 seconds (6 hours).

@ S Server Manager T B
Manage Services 0GC Services KML Netwark Links Sharing
Editing: Site (root) > System > PublishingToals Help Save and Restar
C il
R umibe In
Tiber st I
Capabilities
- ” |

» Click Save and Restart.

Copyright © 1995-2021 Esri. All rights reserved.
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ArcGIS Data Appliance: Esri Vector Basemaps

« Sign out of ArcGIS Server Manager.

ArcGIS Data Appliance 2022: Esri Vector Basemaps is delivered on a USB flash drive loaded with vector tiles,
styles, and style publishing tools. Copy all contents of the USB flash drive to your local computer.

Copyright © 1995-2021 Esri. All rights reserved.
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Setup

Copyright © 1995-2021 Esri. All rights reserved.
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Set up ArcGlIS Data Appliance: Esri Vector Basemaps

Instructions for how to set up ArcGIS Data Appliance: Esri Vector Basemaps depend on whether you are a new or an
existing user, as follows:
* New user

+ Existing user

When you've completed setting up ArcGIS Data Appliance: Esri Vector Basemaps, your vector basemaps will be
ready to use.

Copyright © 1995-2021 Esri. All rights reserved. 23
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Set up Esri Vector Basemaps (new user)

For information about what's included with Esri Vector Basemaps, see Esri Vector Basemaps content.

I Note:
Before you proceed, review the system requirements to confirm that you can deploy Esri Vector Basemaps on your

system.

Once you confirm that the system requirements are met, the workflow to set up Esri Vector Basemaps is as follows:
1. Upload the package to your ArcGIS Enterprise portal

2. Publish the hosted tile layer (service)

3. Publish tile layers (map styles)

4. Share tile layers (map styles)

I Note:
Esri Vector Basemaps includes two vector tile packages (.vtpk) on the flash drive. The

Esri_Vector_Basemap_DA2022_Install.vtpk file is in the Web Mercator Auxiliary Sphere (WMA) projection. The
Esri_Vector_Basemap_GCS_DA2022 Install.vtpk file is in the WGS84/GCS (GCS) tiling scheme. The following

steps reflect the sharing process of the WMA vector tile package. To share the GCS package, you need to enter the
correct .vtpk file name for the input package as well as take the GCS naming into consideration when publishing

the hosted tile layer. The Esri Vector Basemaps styles in the GCS directory already take the GCS naming into account
in the metadata files.

Upload the package to your ArcGIS Enterprise portal
First, you need to copy the entire USB flash drive contents to your local computer if you have not already done so.

1. Start ArcGIS Pro, sign in to your ArcGIS Enterprise portal, and select Set As Active Portal.

Portals

E_,_@ https://your portal name/portal/

Available : Signed in as

Save As

Portals

I Note:

You must sign in and connect to your portal before you proceed. You cannot enter your portal user name and
password when using the Share Package tool later in these instructions. The tool obtains your credentials from
ArcGlIS Pro.
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2. Create a project.

3. Select the Analysis tab, and select Tools in the Geoprocessing group.

[~ == - - 3

Home nsert Analysis View magery share
QD P HEE LB O OB 3

History Python ModelBuwilder Environments Tools Ready To Feature Raster Spatial Chip ntersect
Use Tools~  Analysis~ Analysis ~ ain

Geapracessing : Portal
The Geoprocessing pane appears.

4. In the Geoprocessing pane, search for Share Package, and select the Share Package (Data Management
Tools) tool from the search results.

Geoprocessing X
(_—_,' |Share Package X - 'b'
A
Share Package C nagement Tooks
Shares a package by uploading to ArcGIS Online or ArcGIS
Enterprise.
-

Create Mobile Scene Package (Cztz Manzgement Tooks
Creates a mobile scene package file (.mspk) from ene or more
scenes for use across the ArcGlS platform.

-

Package Map (Cztz Management Tocks
Packages a map and all referenced data sources to create a single
compressed .mpkx file,

-

5. In the Share Package dialog box, provide the following:
a. For Input Package, provide the path to the vector tile package, for example, C:\Projects\
Esri_Vector_Basemaps_2022\VTPK\Esri_Vector_Basemap_DA2022 Install.vtpk.

b. For Summary, type Esri Vector Basemap for Data Appliance 2022.

c. For Tags, type 2022, v2.
A\ Caution:

Do not change the Credits parameter value and do not check the boxes to share with Everybody or Within
Organization.
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Geoprocessing > x

® Share Package @®

(3

Parameters Environments |

Input Package
C\Projects\Esn_Vector_Basemaps_202\VTPK\Esn_Vector_Basemap_DA2022 Installvipk

Summary
Esri Vector Basemnap for Data Appliance 2022

Tags
2022, w2
Credits

6. Select Run.
It will take approximately 30-120 minutes to upload the package to your portal. A Share Package Uploaded
Successfully message appears in the Share Package window once the upload is complete.
7. Through your portal, confirm that the .vtpk file uploaded successfully.
a. Open a web browser and sign in to your portal.
The Esri_Vector_Basemap_DA2022_Install tile package is located in the root folder.

b. Confirm that the Size value of the tile package is 34,497 MB and Shared with indicates that the item is not
shared.

Your item should look like the following:

Esri_Vector_Basemap_DA2022 Install #

Open in ArcGIS Deitop

&esn
DATA APPLIANCE 2022
WMA

» Ewi_Voctor_Basomap_DAZ0Z2_Inetsll. This vectos tile paciage i for put ng the ted)vector J—

» Ewi_Weetor Basemap v2- Oreg put

Terms of Use

Impartant Use Requirerments: Thes Ly

I Note:
If the size is not 34,497 MB, delete the item and upload the Esri_Vector_Basemap_DA2022_Install tile package
again. You may want to discuss the problem with your portal administrator.

For the Esri_Vector_Basemap_GCS_DA2022_Install tile package, if the size is not 34,101 MB, delete the item and
upload it again.

See the Troubleshooting Esri Vector Basemaps topic for more information.
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Publish the hosted tile layer (service)
Now you'll publish the Esri Vector Basemap hosted tile layer service from your portal.

1. Sign in to your ArcGIS Enterprise portal.

I Note:
Your account must have publishing credentials.

2. In My Content, go to the item page for the vector tile package
(Esri_Vector_Basemap_DA2022_ Install.vtpk) you uploaded to your portal.

3. Click Publish, change the title to Esri_Vector_Basemap_v2, and click Publish again.

Publish p 4
Publish this item as a hosted layer.
E ector_Base = 3
2022 ¥ ||v2 X
I Note:

For the GCS tile package (Esri_Vector_Basemap_GCS_DA2022_Install.vtpk), change the title to

Esri_Vector_Basemap_GCS_v2.

I Note:
It will take 30-120 minutes to create the hosted layer, depending on your system configuration.

The Esri_Vector_Basemap_v2 hosted tile layer is created.

Title
B8 Esri_Vector Basemap_ Tile Layer {hosted &
ai E e emap_DA ector Tile Package &

Publish tile layers (map styles)

You'll publish your map styles next.
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The VectorStylePublisher geoprocessing toolbox can be run in ArcGIS Pro. This toolbox publishes 51 new tile layers

to your portal.

These instructions assume that the toolbox and VectorBasemapStyles folder are on your local computer.

&= S » ThisPC » OSDisk (C) » Projects » Esn_Vector_Basemaps_2022 »
Program Files (x86) I Marme X Type

= Projects Toolbox e folde

act Esri_Vector_Basemaps 2002 VectorBasemapStyles File falder
Teelbex VTPK e falde
VectorBasemapStyles () data_appliance_esri_vector_basemaps Microsof D
VIPK

I Note:

You must have a portal account assigned to the default publisher or administrator role, or your account must be
assigned to a custom role that has privileges to create content and publish hosted tile layers.

1. Start ArcGIS Pro, sign in to your ArcGIS Enterprise portal, and select Set As Active Portal.
2. Create a project.

3. Select the View tab, select Catalog View in the Windows group, right-click Toolboxes, and select Add
Toolbox.

S == - - 3z
Catalog nsert Analysis View Imagery Share
D—r' j:l » | — A /] Show Details Pane = Display Type -
By ' : vi= r -
- . | Search My Organization| More Detail
Reset Catslog Catalog Contents Python Tasks Reviewer Workflow
Panes= Pane View Rules Manager= || Show Pop-ups
Windows Options
JAIIN = cociog x|
1‘ —l » Project »
Maps
= GH Add Toolbox M
Bl Mew Toolbox Add Toolbox
Bl Mew Python Toolbox . R . .
. - Add an existing toolbox to the project. The project
Da saves a reference to the toolbox.

4. Browse to the location on your local computer where you copied the contents of the USB flash drive, select
VectorStylePublisher.tbx, and select OK.

Copyright © 1995-2021 Esri. All rights reserved.

28



ArcGIS Data Appliance: Esri Vector Basemaps

Add Toolbox

x
3:? "ﬂ =< O5Disk (C) » Projects v Esri_Vector_Basemaps 2022 » Toolbox » = O|| 1= Search D -
Organize * Newltem = HR|
-
4 | [Esri Vector Basamaps_2022 Name Type
b | = VectorStylePublisher.tbx h Toolbox
b [ VectorBasemapStyles B VectorStyleUpdater.thx Toolbox
P o VIPK

v
> -

Name | VectorStylePublisher. tha .! Toolboxes (Al Types)

o]

The VectorStylePublisher toolbox is added to the project.
5. Double-click Toolboxes and double-click VectorStylePublisher.tbx.

@ ®||E| » Project » Toolboxes »

WyProject.tbx

Toolbox

VectorStylePublisher.tbx

Toolbox

10/25/2018 1135 AM

6. Double-click the Vector Style Publisher script.

= Catalog X

@ @“E » Project » Toolboxes » VectorStylePublis

Vector Style Publisher
% Script

7. On the Vector Style Publisher dialog box, select the Parameters tab and provide the following:
Geoprocessing

- 0 x
) Vector Style Publisher (&)
Parameters Environments @

Folder containing vector styles
|C:\Projects\Esri_‘urector_Basemaps_?.OlZ\‘u’ectorBasemapStyIes\WMA_Sters\WMﬂ_NewUser | !
Vector Tile Service URL

| https:// <portal_name> / arcgis/rest/services/Hosted/Esri_Vector_Basemap_v2/VectorTileServer |
Metadata felder name

| metadata |

[] Share vector style web layers publicly
* PKI Authorization
¥ Linux LDAP
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a. For Folder containing vector styles, browse to the location of the VectorBasemapStyles folder on your local
computer, for example, C:\Projects\Esri_Vector_Basemaps_2022\VectorBasemapStyles\

WMA_Styles\WMA_NewUser.
b. For Vector Tile Service URL, provide the URL of the Esri Vector Basemap hosted tile layer, for example,
https://portalname.domain.com/arcgis/rest/services/Hosted/Esri_Vector_Basemap_v2/

VectorTileServer.

I Note:
The vector tile service URL is found in the URL section of the Esri_Vector_Basemap_v2 hosted tile layer item

page. Click the Copy button and paste the URL in the Vector Tile Service URL parameter text box.

Esri_Vector_Basemap v2 &

-
oyl
@esri
DATA APPLIANCE 2022
WMA Ty
o=
{; (=14}

c. For Metadata folder name, keep the default name metadata.

I Note:
If you are using a portal with PKI authentication, expand PKI Authorization and provide values for the

PKI_Certificated_file_(.pfx) and PKI Private Password parameters.

v PKI Authorization
PK|_Certificated_file_(.pfx)

PKl Private Password

If you are using a portal with Linux LDAP authentication, expand Linux LDAP and provide information for
the Sign In Username and Sign In Password parameters.

¥ Linux LDAP

Sign In Username

Sign In Password
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d. Click Run.

The 51 vector tile layers (map styles) are created in your assigned ArcGIS Enterprise account. You can view the items
in My Content. Fifty-three items are listed: 51 vector tile layers, the . vtpk file, and the hosted tile layer.

Share tile layers (map styles)

The items created are private unless you check the Share vector style web layers publicly check box to make
them public.

Geoprocessing e

@

®© Vector Style Publisher

WL

3]

Parameters Environments [
Folder centaining vector styles S _— —
C\Projects\Esri_Vector_Basemaps_2022\VectorBasemapStyles\WIMA_Styles\WMA_NewUsed
Vector Tile Service URL - - o - -
| http=:// <portal_name> / arcgis/rest/services/Hosted/Esri_Vector_Basemap_v2/VectorTileServer
Metadata folder name
metadata

Fhare vector style web layers publicly
* PKI Authorization
¥ Linux LDAP

Alternatively, you can select the map items in your portal and change the sharing settings.

Share
Share the itern(s) with:

Everyone

Authentication

Theze settings will replace the curre

Mo groups available to share to.

0K _BnCe
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I Note:

Delete protection for all items is applied upon publishing the tile layers. To change the protection setting, open the
item and click the Settings tab. Under Delete Protection, uncheck Prevent this item from being accidentally
deleted and click Save.

Dark Gray Canvas Base

Settings

General  Tile Layer

General

Content Status

Discourage the use of this item.

‘ Mark as Deprecated

Delete Protection

@uerl: this itemn frem being accidentally deleted.

Extent

‘ Set Extent

Once you set up Esri Vector Basemaps, you can do the following:
* Use Esri Vector Basemaps
 Customize styles

* Localize styles
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Set up Esri Vector Basemaps (existing user)

These steps are for updating your Esri Vector Basemaps in WMA.

I Note:
To use Esri Vector Basemaps in the GCS format, complete the steps using the information for GCS.

For information about what's included with Esri Vector Basemaps, see Esri Vector Basemaps content and What's
new.

You'll use the following workflow to update Esri Vector Basemaps:
1. Upload the package to your ArcGIS Enterprise portal

2. Publish the new hosted tile layer (service)

I Note:
The title of your new hosted tile layer must be different than the title of your existing hosted tile layer (for

example, the name of the new layer is Esri_Vector_Basemap_DA2022_v2).

Replace the existing hosted tile layer (service) with the new hosted tile layer

Update existing tile layers (map styles)

v~ W

Publish new tile layers (map styles)
6. Share tile layers (map styles)
Upload the package to your ArcGIS Enterprise portal

First, you need to copy the entire USB flash drive contents to your local computer if you have not already done so.
Review the system requirements to confirm that you can deploy the Esri Vector Basemaps update.

1. Start ArcGIS Pro, sign in to your ArcGIS Enterprise portal, and select Set As Active Portal.

Portals

C:Qi https://your portal name/portal/

Awailable : Signed in as

Save As .
Test Availab ity

I Note:
You must sign in and connect to your portal before you proceed. You cannot enter your portal user name and

password when using the Share Package tool later in these instructions. The tool obtains your credentials from
ArcGIS Pro.

2. Create a project.
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3. Select the Analysis tab, and select Tools in the Geoprocessing group.

[ SIS = v r 5

Home nsert Analysis VIEwW magery ahare
O 3 % ma B B\ 5

Histery Python ModelBuilder Emvironments Teols Ready To Feature Raster Spatial Clip ntersect

Use Tools~  Analysis= Analysis ~ Join
Geoprocessing E) Portal

The Geoprocessing pane appears.

4. In the Geoprocessing pane, search for Share Package, and select the Share Package (Data Management
Tools) tool from the search results.

Geoprocessing X
® x| @
A
Share Package (Dztz lMznzgement Took
Shares a package by uploading to ArcGIS Online or ArcGIS
Enterprise.
s

Create Mobile Scene Package D=tz IMznzgement Took

Creates a mobile scene package file (.mspk) from ene or more
scenes for use across the ArcGl5 platform.

-

Package Map (Datz Manzgement Tooks
Packages a map and all referenced data sources to create a single
compressed .mpkx file,

-

5. On the Share Package dialog box, provide the following:
a. For Input Package, provide the path to the vector tile package, for example, C:\Projects\

Esri_Vector_Basemaps_2022\VTPK\Esri_Vector_Basemap_DA2022 Install.vtpk.
b. For Summary, type Esri Vector Basemap for Data Appliance 2022.

c. For Tags, type 2022, v2.

/A, Caution:
Do not change the Credits parameter value and do not check the boxes to share with Everybody or Within
Organization.
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Geoprocessing > x

® Share Package @®

(3

Parameters Environments |

Input Package
C\Projects\Esn_Vector_Basemaps_202\VTPK\Esn_Vector_Basemap_DA2022 Installvipk

Summary
Esri Vector Basemnap for Data Appliance 2022

Tags
2022, w2

Credits

6. Select Run.
It will take approximately 30-120 minutes to upload the package to your portal. A Share Package Uploaded
Successfully message appears in the Share Package window once the upload is complete.

7. Through your portal, confirm that the .vtpk file uploaded successfully.
a. Open a web browser and sign in to your portal.
The Esri_Vector_Basemap_DA2022_Install tile package is located in the root folder.

b. Under Details, confirm that the Size value of the tile package is 34,497 MB and Shared with indicates that
the item is not shared.

Your item should look like the following:

Esri_Vector_Basemap_DA2022 Install #

Open in ArcGIS Deitop

&esn
DATA APPLIANCE 2022
WMA

» Ewi_Voctor_Basomap_DAZ0Z2_Inetsll. This vectos tile paciage i for put ng the ted)vector J—

» Ewi_Weetor Basemap v2- Oreg put

Terms of Use

Impartant Use Requirerments: Thes Ly

I Note:
If the size is not 34,497 MB, delete the item and upload the Esri_Vector_Basemap_DA2022_Install tile package
again. You may want to discuss the problem with your portal administrator.

For the Esri_Vector_Basemap_GCS_DA2022_Install tile package, if the size is not 34,101 MB, delete the item and
upload it again.

See the Troubleshooting Esri Vector Basemaps topic for more information.
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Publish the new hosted tile layer (service)
Now you'll publish the Esri Vector Basemap hosted tile layer service from your portal.

1. Sign in to your ArcGIS Enterprise portal.

I Note:
Your account must have publishing credentials.

2. In My Content, go to the item page for the vector tile package
(Esri_Vector_Basemap_DA2022_ Install.vtpk) you uploaded to your portal.

3. Click Publish, change the title to Esri_Vector_Basemap_DA2022_v2, and click Publish again.

Publish X

I Note:
For the GCS tile package, use the Esri_Vector_Basemap_GCS_DA2@22_Install.vtpk file. Change the title to

Esri_Vector_Basemap_GCS_DA2022_v2 for the hosted tile layer that gets published.

I Note:
It will take 30-120 minutes to create the hosted layer, depending on your system configuration.

The Esri_Vector_Basemap_DA2022_v2 hosted tile layer is created.

Title
B8 Esri Base 2 Tile Layer (hosted &
B E Basemap_DA ector Tile age &

Replace the existing hosted tile layer (service) with the new hosted tile layer
(service)
Next, you'll replace the 7.2 basemap hosted tile layer (service) with the 2022 hosted tile layer (service).
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1. Sign in to your ArcGIS Enterprise portal.

I Note:
Your account must have publishing credentials.

2. In My Content, go to the item page for the Esri_Vector_Basemap_v2 vector tile service.

3. Click Replace Layer.

Esri_Vector_Basemap_v2 #

- 1

@esri
DATA APPLIANCE 7.2

4. Click Select.

I Note:
If you're using an ArcGIS Enterprise 10.7.1 portal, click Select layer and select the newly published

Esri_Vector_Basemap_DA2022_v2 layer.

Replace Layer

Replacement Layer

Select layer

5. For Archive the current layer as, click the edit button and change the value to
Esri_Vector_Basemap_DA72_v2 and click Save. Then, if you're using an ArcGIS Enterprise 10.8 or later portal,

scroll to Replace Item information and turn it on.
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®  Archive the current layer as &su_'femm_Basemgp_UMZ_u:@

The content of the curent layper is archived. A new layer i created to archive the cument layer. The replacerment layer is deleted sfenwards.

Currack Layar

» The item id and UAL of the current layer is retsined 30 that apps and stles
referancing the layer continue 1o work

» The cantent of the current layer is.archived 5.2 new layer.

* Tha replacemant layer is delated afier the curment Layer is replaced.

« Idsal for crmating designated lapers dor anchives.

~

0 Use the replacement layer as the archive

Tha content of tha current layer is swapped with the cantent of the replacement layer,

Cusrrans Layar

* Ma new layers ane creafed. The ftem id and URL of bath the curnend layer and

replacomant layer ace rotained so that apps and styles relensncing the layers k|
cantinug 1o wark
. ::;H«:;r»-arm;|ha|donmmn|1ocrur.udnan.wImrfor
i Taplacman Ly : ::

Replace item information ©
This will Lipelate the iterm infeemation fram the replacement laper, inluding: thumbeail, ummary, descripsan, and tags.

6. Click Next.

7. On the Replace Layer summary, click Replace.
Replace Layer @ X

Select replacement layer Cheose archive option Summary

Cusrrint Laar

Esri_Vector_Basemap_v2
I Tila LLsyar by portaladinin

Ronplacnman layer

Esri_Vector_Basemap_DA2022_v2

B Tibe Liryer bry pestalacenion

Salect raplacament layer

Aschive option

= Arghiar th cutfee Lies as Ei_Veoter_Basemap DATZ v2
= Raplace nam afermation

Choows anckive cption

“ —
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I Note:

The current layer starts as DA7.2. The replacement layer is DA2022. You are archiving the DA7.2 hosted tile
layer, and the current layer (Esri_Vector_Basemap_v2) now displays the DA2022 hosted tile layer. Replacing the
tile set allows the item ID and URL paths to remain intact so maps and apps continue to work with the current
layer and display the new DA2022 basemap content.

I Note:
If you're using an ArcGIS Enterprise 10.7.1 portal, check the Replace item information check box. Click
Replace.

Replacement options

M Replace item information.

This will use the following information from the
replacement layer:

» thumbnai

» summary

* gescrnption

» tags
w
Cancel Replace
: —

In a few minutes, the Success message appears.

Replace Layer

v

Success

Your layer has been replaced.

Please verify that dependent maps and layers work as expected.

Close

Click Close.
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If you're using an ArcGIS Enterprise 10.8 or later portal, the Success message flashes briefly at the top of the

screen.
8. To verify a successful replacement, in My Content, go to the item page for the Esri_Vector_Basemap_v2 vector

tile service.
Your item should look like the following:

Esri_Vector_Basemap_v2 ¢

esri
DATA APPLIANCE 7.2
WA

» Ewi_Vector_Basamay p_DATOZ3 eatall. T

= Ewl_Vevior Basemap_ vl

I Note:
The thumbnail is not replaced, but the title is Esri Vector Basemap for Data Appliance 2022 and the Details

indicate it was created from the Esri_Vector_Basemap_DA2022_Install Vector Tile Package.

Update existing tile layers (map styles)
Use the Vector Style Updater tool to update your existing layers.

1. Open the DA2022_WMA_StyleUpdater_template.csv file located in the C:\Projects\

Esri_Vector_Basemaps_2022\Toolbox folder.
a. Include the item IDs of all your existing styles in the itemid column in this table. The item ID for each style
can be obtained from the portal URL for each style. Only copy and paste the series of letters and numbers

after ...id=.
“s Q@ @ & m — e S E R S e ] |

Hame Gallery Map Scene Groups Content Ohrganization

S

AutoSave (@ o) [ ©)- : DAIIZZ WMA,_StylelUpdater - Encel

File Home Insert Page Layout Formulas Data Review Wiew Help 2 search &3 Share 1%
AlG g fe

A B L=

1 |itemid title foldemame
2 |ee2753804caTdT55ac9a113815%08a271  Charted Territory chartedterritory
3 |CTd4654088254eceBBca5ed545961859  Colored Pencil coleredpencil
4 |cfa00T5be5h9496385899cdaf3a5125d Community community

o T

2. Run the Vector Style Updater tool.
a. Start ArcGIS Pro, sign in to your ArcGIS Enterprise portal, and select Set As Active Portal.
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b. Create a project.

c. Select the View tab, select Catalog View in the Windows group, right-click Toolboxes, and select Add
Toolbox.

d. Browse to the location on your local computer where you copied the contents of the USB flash drive, select
VectorStyleUpdater.tbx, and select OK.
The VectorStyleUpdater toolbox is added to the project.

e. Double-click Toolboxes, and double-click VectorStyleUpdater.tbx.
f. Double-click the Vector Style Updater script.

(_-J. TJI [l » Project » Toolboxes » VectorStyleUpdater.thx

Vector Style Updater

g. On the Vector Style Updater dialog box, select the Parameters tab and provide the following:

- o
Geoprocessing T *

- Vector Style Updater +

Parameters Environments

i. For CSV formatted file containing the item name and ids (.csv), browse to the location of the
DA2022_WMA_StyleUpdater.csv file on your local computer.

ii. For Folder containing vector styles, browse to the location of the WMA Updated Styles folder on your
local computer, for example, C:\Projects\Esri_Vector_Basemaps_2022\VectorBasemapStyles\

WMA_Styles\WMA ExistingUser\WMA_UpdatedStyles.

iii. For Vector Tile Service URL, provide the URL of the Esri Vector Basemap tile layer that you replaced
above, for example, https://portalname.domain.com/server/rest/services/Hosted/

Esri_Vector_Basemap_v2/VectorTileServer.
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I Note:
The vector tile service URL is in the URL section of the Esri_Vector_Basemap_v2 hosted tile layer item

page. Click the Copy button and paste the URL in the Vector Tile Service URL parameter text box.

Esni_Vector_Basemap_v2? #

o in Mag Viewsr

g

eesri
DATA APPLIANCE 2022
WMA

iv. For Metadata folder name, keep the default name metadata.

I Note:
If you are using a portal with PKI authentication, expand PKI Authorization and provide values for the

PKI_Certificated_file_(.pfx) and PKI Private Password parameters.

v PKI Authorization
PEI_Certificated_file_(.pfx)

PKIl Private Password

If you are using a portal with Linux LDAP authentication, expand Linux LDAP and provide values for the
Sign In Username and Sign In Password parameters.

v Linux LDAP

Sign In Username

Sign In Password

3. Click Run.
It can take up to a minute to update each existing style in your portal using the Vector Style Updater tool.

The VectorStyleUpdater toolbox displays a successful update message when complete.

The 34 vector tile layers (map styles) are updated in your assigned ArcGIS Enterprise account.
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Publish new tile layers (map styles)

Now that you've published and updated your hosted vector Tile Layer and updated the existing styles, you are
ready to publish the new map styles.

VectorStylePublisher.tbx (~54KB) is a geoprocessing toolbox that is run in ArcGIS Pro. This toolbox publishes

new private map items in your portal for one new vector tile layer and transfers the vector basemap style resource
folders and files and metadata for the map item pages from your local computer to your portal.

1. In the ArcGIS Pro project you created to update the existing styles, select the View tab, select Catalog View in
the Windows group, right-click Toolboxes, and select Add Toolbox.

S == z

Project Catalo nsert
0

Analysis View Share

F

Imagery
/] Show Details Panel = o splay Type =

| Search My Organization__ More Detail

Rsr.s-t Catalog Catalog Contents Python Tasks Reviewer Workflow
Panes~ Pane View Rules Manager= || Show Pop-ups
Windows Options

NEALUPIN = cociog x |

1‘ —| » Project »

Maps
= G Add Toolbox M
B NewToolbox Add Toolbox

Ed Mew Python Toolbox Aelel .
. - Add an existing
saves a reference to the toolbox.

toolbox to the project. The project

2. Browse to the location on your local computer where you copied the contents of the USB flash drive, select
VectorStylePublisher.tbx, and select OK.

VectorBasemapStyles

VTPK

Add Toolbox X
,1-' T < 05Dk (C:) » Projects » Esri_Vector_Basemaps_2022 » Toolbox » ~ ||| 1= | Search 2
Organize ™ New ltem =
] Esri_Vector_Basamaps_2022 Name ‘ype
| Tkt Bl VectorStylePublisher.thx b Toolbox
B VectorSne At ' Taolba
B VectorStylelpdater.thy Toolban

Teolboxes (A1 Types)

[s]4

[ oot

The VectorStylePublisher toolbox is added to the project.
3. Double-click Toolboxes, and double-click VectorStylePublisher.tbx.
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(_-jl le |:| ¥ Project » Toolboxes »

MyProject.tbx

VectorStylePublisher.tbx

4. Double-click the Vector Style Publisher script.

(_—J' ‘!‘,' D » Project » Toolboxes » VectorStylePublis

— Vector Style Publisher

J;[ Serigt

5. On the Vector Style Publisher dialog box, select the Parameters tab and provide the following:
a. For Folder containing vector styles, browse to the location of the WMA New Styles folder on your local
computer, for example, C:\Projects\Esri_Vector_Basemaps_2022\VectorBasemapStyles\WMA\

WMA_ExistingUser\WMA_NewStyles.

b. For Vector Tile Service URL, provide the URL of the Esri Vector Basemap tile layer, for example,
https://portalname.domain.com/arcgis/rest/services/Hosted/Esri_Vector_Basemap_v2/

VectorTileServer.

I Note:

The vector tile service URL is in the URL section of the Esri_Vector_Basemap_v2 hosted tile layer item page.

Click the Copy button and paste the URL in the Vector Tile Service URL parameter text box.

c. For Metadata folder name, keep the default name metadata.
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I Note:
If you are using a portal with PKI authentication, expand PKI Authorization and provide values for the

PKI_Certificated_file_(.pfx) and PKI Private Password parameters.

v PKI Authorization
PKI|_Certificated file_(.pfx)

PKl Private Password

If you are using a portal with Linux LDAP authentication, expand Linux LDAP and provide values for the
Sign In Username and Sign In Password parameters.

¥ Linux LDAP

Sign In Username

Sign In Password

d. Click Run.

With the addition of the new map style, you can view all 51 tile layer items in My Content.

Share tile layers (map styles)
The items created are private unless you check the Share vector style web layers publicly check box to make

them public.

Geoprocessing v

® Vector Style Publisher =
@

Parameters | Ervironments
Folder containing vector styles
rasemanStvles\WMA Stvles\WMA ExistinalUserWMA MewStvles

Vector Tile Service URL
n/server/rest/services/Hosted/Esri_Vector_Basemap_v2/VectorTileServer

Metadata folder name
metadata

Share vector style web layers publicly

Alternatively, you can select the map items in your portal and change the sharing settings.

Copyright © 1995-2021 Esri. All rights reserved.

45



ArcGIS Data Appliance: Esri Vector Basemaps

Share

Share the itern(s) with:

Everyone

Authentication

These settings will replace the current semtings.

Mo groups available to share to.

Once you set up the Esri Vector Basemaps update, you can do the following:
* Use Esri Vector Basemaps
 Customize styles

* Localize styles
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Troubleshooting Esri Vector Basemaps

Listed below are issues you may encounter when working with Esri Vector Basemaps content as well as
recommended solutions.

« What if the size of the uploaded .vtpk file does not match the size of the source .vtpk file?
« What if | encounter the There was an error message when | try to publish the service?

» What do | do if the progress bars keep loading when I'm trying to publish my service?

Copyright © 1995-2021 Esri. All rights reserved.
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What if the size of the uploaded .vtpk file does not match the size of the source .vtpk file?

If your tile layer (hosted) service did not publish successfully, an issue may have occurred during the upload of the
vector tile package (.vtpk) to your portal. The size of the . vtpk file on disk and the size of the uploaded file on
your portal must match.

The size of the Esri_Vector_Basemap_DA2022 Install.vtpk file is 34,497 MB and the
Esri_Vector_Basemap_GCS_DA2022_Install.vtpk file is 34,101 MB.

You can check the size of the uploaded vector tile package (supporting the service) on the item details page. The
following screen capture shows the Esri_Vector_Basemap_DA2022_install vector tile package details.

Details

Size: 34,497 ME

Share

]

Sharing level: Owner.

If the size does not match, check the log via the server manager to see if there are any errors.

In some cases, the ArcGIS Pro Share Package geoprocessing tool may have produced a Success message, but when

you check the size of the .vtpk file on the item details page, it does not match. Here are some things that you can

try to resolve this issue:

 Upload the .vtpk file again. First, delete the Esri_Vector_Basemap_DA2022_Install.vtpk or
Esri_Vector_Basemap_GCS_DA2022_Install.vtpk file from your portal. Next, upload the
Esri_Vector_Basemap_DA2022_Install.vtpk or Esri_Vector_Basemap_GCS_DA2022_Install.vtpk file
again using the ArcGIS Pro Share Package geoprocessing tool.

« Verify with your portal administrator that there is at least 70 GB of disk space per .vtpk file available on your
portal. Make sure there is space on <ArcGIS portal install drive>\arcgis\arcgisportal where the
content items are stored.

« Verify that you are using a supported version of ArcGIS Pro. See the system requirements for details.

Contact Esri Technical Support if you still cannot successfully upload the . vtpk file.

I Note:
The following answers reflect troubleshooting of the WMA vector tile package and service. To troubleshoot the GCS
vector tile package and service, you need to take the GCS naming into consideration.
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What if | encounter the There was an error message when I try to publish the service?
Work with your system administrator to check the ArcGIS Server Manager logs.

If there is an error due to a geoprocessing service (PublishingTools) timing out or crashing, you may have skipped a
system requirements step. Confirm that you changed the value of The maximum time a client can use a service
to 21,600 seconds.

Once you have updated the geoprocessing service maximum time, do the following:

1. On your server, delete the Esri_Vector_Basemap_v2 or Esri_Vector_Basemap_GCS_v2 hosted tile layer.

2. On the ArcGIS Server machine, delete the job in the <ArcGIS_Server_Install_Path>\arcgis\

arcgisserver\directories\arcgisjobs\system\publishingtools gpserver\<Job_ID> folder.

I Note:
You can find the job ID in the log file.

3. Restart the server.

4. Verify that you have at least 70 GB of available space per .vtpk file on ArcGIS Server.

5. In your portal, publish the Esri_Vector_Basemap_v2 or Esri_Vector_Basemap_GCS_v?2 tile layer again.
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What do | do if the progress bars keep loading when I'm trying to publish my service?

Overview

# Edit Thumbnail

Creating Service

* Add to Favorites

If the Creating Service animated bars continue to load after two hours, the browser connection to the portal may
have failed.

Sign out of the portal and sign in again to see if the thumbnail has changed to the Data Appliance 2022 icon,
because the browser connection does not affect the creation of the service.

Esri_Vector_Basemap_DA2022_v2

# Editthumbnail
A_‘ Esri Vector Ba
= ® Tile Layer (F
@esri Created: Jun 15
DATA APPLIANCE 2022
WMA

¢ Add to Favorites

If the thumbnail changes to the Data Appliance 2022 icon, verify that the map displays as expected.
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Additional resources

The following resources are available for Esri Vector Basemaps:

ArcGIS Data Appliance 2022: Esri Vector Basemaps help [PDF]

ArcGIS Data Appliance 2022: Esri Vector Basemaps New users video [captioned MP4] demonstrating uploading,
updating and publishing Esri Vector Basemaps to your portal

ArcGIS Data Appliance 2022: Esri Vector Basemaps Existing users video [captioned MP4] demonstrating
uploading, updating and publishing Esri Vector Basemaps to your portal

ArcGIS Data Appliance: Esri Vector Basemap Reference Document (v2) [PDF]
Tile layers, Customize basemaps, and Choose basemap in the Portal for ArcGIS help
Working with and Customizing Esri Vector Basemaps: The Basics blog post

Create a custom basemap style using the ArcGIS Vector Tile Style Editor on the ArcGIS Developer website (for
ArcGIS 10.8 or later users only)
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Use
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Use Esri Vector Basemaps

With the addition of vector tile packages (. vtpk), hosted tile layers, and tile layers in your portal, you will have a
number of items in your ArcGIS Enterprise Content window. With the correct administrative privileges, you can
create folders, groups, and categories. By creating folders and moving items into them, you can organize your
Content window to make it easier to find the items you are looking for. The following image shows some folder
name suggestions. See Manage content in the Portal for ArcGIS help for information about managing content in
ArcGIS Enterprise.

Home Gallery Map Scene Groups Content Qrganization

Content My Content (U

Folders & 1-20 of 53 in All My Content
@, Filter folders m Title

= All My Conten .

E L e 8 Gray Canva @ Layer

™

lrd =
M D Tile e
® Tarrain Reference (Loca age Tile Laye
B Modemn A e Tile Laye
18 ma eograp U Ueta Tile aye

You can use Esri Vector Basemaps in your applications in the following ways:

* The 51 map tile layers (styles) can be added to a map in ArcGIS Pro or to Map Viewer Classic in your Enterprise
portal.
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* The tile layers (styles) can be added to an existing basemap, or they can be added as the basemap.
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Add to Map

« Seventeen of the 51 map tile layers (styles) can be used with a raster layer—World Hillshade, World Imagery, or
World Ocean Base—as the basemap in their web map.
* Charted Territory—World Hillshade

= Modern Antique—World Hillshade

= National Geographic Style—World Hillshade

= National Geographic Style (Local Language)—World Hillshade
= World Street Map (with relief)—World Hillshade

= World Street Map (with relief - Community Maps)—World Hillshade
= World Terrain Base—World Hillshade

= World Terrain Reference—World Hillshade

= World Terrain Reference (Local Language)—World Hillshade

= World Terrain with Labels—World Hillshade

= World Terrain with Labels (Community Maps)—World Hillshade
= World Topographic Map—World Hillshade

* World Topographic Map (Local Language)—World Hillshade

= Hybrid Reference Layer—World Imagery
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= Hybrid Reference Layer (Community Maps)—World Imagery
= Hybrid Reference Layer (Local Language)—World Imagery
= World Ocean Reference—World Ocean Base

« If you have a tile layer (style) in your map, it can be moved to the basemap.

fome My Map

* Add -

[Z] Details

Contents

 The Dark Gray and Light Gray Canvas Reference layers can be moved to the basemap and set as the Reference
layer over the Canvas Base layer. This is also applicable for the World Terrain Base and Reference, Hybrid
Reference, Human Geography Labels, and Human Geography Dark Labels tile layers.

N "
= My Map

Contents
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Customize styles

With ArcGIS Data Appliance: Esri Vector Basemaps, you can modify and customize the map style. You can customize
the map by changing the hex color codes of map features or labels, removing feature classes, changing fonts (face,
size, and color), or making other edits. For more information, see the vector basemap blog post on the ArcGIS Blog
website.

Customization requires changes to the map style's resources\styles\root. json file. There are two main ways to
customize your maps: add a style to the map in Map Viewer Classic or copy a root. json style from the USB flash

drive. In ArcGIS Enterprise 10.8 or later, you can use the ArcGIS Vector Tile Style Editor. Then you can edit the
custom style map item to include a new thumbnail and update the item's information for your custom style.

Add a style to the map in Map Viewer Classic and rename the style
To add a style using Map Viewer Classic, complete the following steps:

1. In your Enterprise portal, open the style you want to customize in Map Viewer Classic, for example, Dark Gray
Canvas Base.

2. Click More Options ---, and select Copy.

me » T'.f'l"-,-' M ap

tail * Ad Basem
About Content Legend
Contents
# Dark Gray Canvas Base
¥ 3 Loom to
Transparency
£% Set Visibility Range
Rename
Remove

| Copy
3 Move to Basemap

1 Show Item Details

A new Dark Gray Canvas Base - Copy layer is added to the top of the Contents pane.

3. Click More Options ---, and select Save Layer.
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Home w» M\j MJ[Z?
| B petsits | #% ade ~ | BEB:
\ |
@ sbout [I] Content I Lec
Contents
# Dark Gray Canvas Base - Copy
@ p & Zoom to

"1 Transparency

f 2% Set Visibility Range

W Move down
Rename
x Remove

Copy
Move to Basemap

| Description

gm | B @2

Save Laver

4. Rename the style, for example, Custom Canvas Base, and select the portal folder where you want to save the
new style.

5. In My Content, go to the item page for the new style, and click the Download style button.
Custom Canvas Base e

A Edit =
OpaninM... w
This vector tile layer provides a detailed # Ed
biase st fark neutral _ £

e i Last Modified m

The style (root. json file) is saved to your computer.

6. Open the root. json file in a text editor such as Adobe Brackets or Notepad++, and edit and save the file.
Edits to the root. json file can be color value, line width, font size, and so on.

7. Validate the JSON using JSONLint or a similar JSON validation tool. You can also use this website to parse the
JSON into a more user-friendly format before editing.

8. On the item page for the new style, click the Update button to update the item and load the modified
root. json file from your computer to your portal.

Copy a style from the USB flash drive and rename the map style directory

To copy a root.json style from the USB flash drive, complete the following steps:

1. On your local computer, create a directory called CustomStyles at the same directory level as the GCS and
WMA directories.
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» Projects » Esri_Vector_Basemaps_2022 » VectorBasemapStyles

o

Name Type
Custom5tyles File folder
GC5_styles File folder
WA _styles File folder

2. Copy a style from the USB flash drive and rename the map style directory; for example, copy the canvasdarkbase
directory into a new directory and change the name to customcanvasbase.

“ N « O5Dwk(C) » Projects » Esni_Vector Basemaps 2022 » VectorBasemapStyles » CustomStyles » customcanvasbase »

Esri_Vector_Basernaps_2022 A Name Type

Toolbox metadats File

VectorBasemapStyles reSOUnCEs File
CustamShyles
customzanvasbase
GCS styles
WIMEA_styles

VTPK
3. In the new customcanvasbase directory, open the resources\styles\root. json file (for example,
CustomStyles\customcanvasbase\resources\styles\root.json ) in a text editor such as Adobe Brackets

or Notepad++, edit the map code, and save the file.
An example of a style edit in the root. json file is changing the highways in dark gray (#2A2B2B) to red

(#FF0000).
e e A
"id": "Road/Highway/1", *id": "Road/Highway/1",
"type™: "line", "type™: "line™,
"source®: "esri”, "source®: "esri®,
"scurce-layer”: "Road", "source-layer™: "Road",
"filtar”: ["all", ["=", "_aymbol", 1], "Filtar®: ["all®, ["=", " symbal®, 1],
[Hlias.-Yviz®: 31 [*!in", "Viz", 3]
1. 1.
"minzoom": 8, "minzoom": B,
"layout™: | "layout™: |
"line=join": "round" "line=join": "round"

Fe 1.

"paint": | "paint": |

nlin:—cclo "line-color
"line-width"? "line—width":

"base": 1.2, “base®: 1.2,

"stops™: | "stopa™: [
&, 0.31, I8, 0.31.
[14, B.3], [14, B.3].

4. In the new customcanvasbase directory, open the metadata\metadata. json file (for example, CustomStyles\
customcanvasbase\metadata\metadata.json) in a text editor such as Adobe Brackets or Notepad++, and
edit "title":, replacing "Dark Gray Canvas Base" with a new map title, for example, "Custom Dark Base",

and save the file.
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[=] metadata json E3

"owner": "esri",

:_’ I‘OrgId": " II’
6 "created™: 1479514141000,
7 "modified": 1501816841000,

B "guid": null,
9 "name": null,
10 "title": "Dark Gray Canvas Base",
"type": "Vector Tile Service",
12 "typeKeywords": ["Data", "Service", "Vector
Service"],
13 "description™: "<div style='font-family:
&guot;Avenir Next WOlagquot;, &guot;Avenir Ne

WANT st - fenimt = Raranma v Moawd fenad - Nrrama w

5. Validate the JSON using JSONLint or a similar JSON validation tool.

6. Perform the Publish tile layers (map styles) steps, this time pointing to the new directory containing your custom
style.

The new style is created in your Enterprise portal under My Content. Following the naming conventions in steps
1-4 produces a new item in your portal named Custom Canvas Base.

Edit the custom style map item in your portal

On the map item page of your custom map style, you can update the summary, description, tags, and thumbnail to
better describe the new map you styled.

It is recommended that you apply Delete Protection to your custom style map item on the item's Settings tab.

Custom Dark Base /e

Usage Settings

Description

his vector tile layer is a customized version of the Dark Gray Canvas Base.

The transportation network has been changed to red roads to provide better visiblity of the roads across the map.
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Esri Vector Tile Style Editor

In ArcGIS Enterprise 10.8 or later, you can customize vector map styles through an app in the Map Viewer Classic.
Access the Style Editor from the Change Style button under any Esri vector basemap tile layer. Save the new style
to your portal.

[E] Details & Add BB Basemap | [ Analysis

About  [E] Content

11
[
i}

w
i1}
=}
[

Contents

: ¢l Light Gray Canvas

’ ““ Change Style

Styling options include the Quick Edit tool, in which layers are customized across groups of features, and the Layer
Style Editor list for individual feature style controls. Colors, line weights, font faces, and sprite symbology are
examples of the style changes that can be applied to your custom map item.

Change Style

’
-
L
]
+
=}
“
[-] [ &
I
= \
X !
s “
>
Aa N;J N
d
1.7
T T

Information about using the ArcGIS Vector Tile Style Editor to Create a custom basemap style is available on the
ArcGIS Developer website.
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Localize Esri Vector Basemap styles

ArcGIS Data Appliance: Esri Vector Basemaps supports localizing select map labels into the languages listed below.
The default map displays a primarily English global view. Localization is another form of basemap customization. As
with other customization, there are two main ways to create a style for customization: add a style to the map in
Map Viewer Classic or copy a root. json style from the USB flash drive. Review the information in the previous
section on how to Customize Esri Vector Basemap styles.

Localization changes the labels on the map for many of the small-scale features when the data supports it. Localize
the map by changing the "text-field" value of the map style's resources\styles\root. json file. Use the
corresponding codes for the language you want to display. It is also recommended that you change all "text-
font" to an Arial Unicode font to allow all glyphs to display on the map. After the localization changes are applied

to your JSON, validate the JSON using JSONLint or a similar tool, and update or upload the new localized map style
as previously detailed in this help document.

Languages and codes supported in Data Appliance 2022
The following language codes are supported in Data Appliance 2022:
Language Code

Arabic ar

Chinese (Hong Kong) = zh_hk

Chinese (Simplified) zh_s

Chinese (Taiwan) zh_tw
Czech cs
Danish da
Dutch nl
Estonian en
Finnish fi
French fr
German de
Greek el
Hebrew he
Italian it
Japanese ja
Korean ko
Latvian Iv
Lithuanian It
Norwegian no
Polish pl
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Language Code
Portuguese (Brazil) pt_br
Portuguese (Portugal) pt_p

Romanian ro
Russian ru
Spanish es
Swedish Y
Thai th
Turkish tr
Ukrainian uk
Vietnamese vi

Features supported for localization

The following features can have their "text-field" values changed to support these languages. The map labels

that can be localized are primarily features displayed at small scale. At large scale, the default JSON labels the map
in English "{_name_global}" or you can change it to the local language "{_name_local}" in each country where

the map data supports it. Apply the small scale feature changes first, before any changes to large scale features.
Using a text editor, find each "id" name and change its "text-field" value accordingly.

Small scale features
The default JSON for these features is "text-field": "{ name_global}". Listed below are the 88 "id" fields in

the worldtopomap style JSON available for localization when the data supports it at primarily small scales. Other
styles may have all or fewer of these features.

For example, to display the map in Chinese (Simplified), the JSON for each of these features changes "text-
field": "{_name_global}" to "text-field": "{_name_zh_s}", for French, "text-field": "{_name_fr}",
and so on.

City small scale/large
non capital

Water point/Sea or Water area large scale/label/

ocean River City large scale/medium

Water area large scale/label/ City small scale/large

Water point/Island City large scale/large

Water point/Dam or
weir

Water point/Playa

Water point/Canal or
ditch

Water point/Stream or
river

Lake or lake intermittent

Water area medium scale/label/

Default

Water area small scale/label/

Default

Marine waterbody/label/small

Marine waterbody/label/
medium
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City large scale/x large

City small scale/town
small non capital

City small scale/town
large non capital

City small scale/small
non capital

adminO capital

City small scale/x large
non capital

City small scale/x large
admin1 capital

City small scale/x large
adminO capital

Admin0 point/2x large
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Water point/Lake or
reservoir

Water point/Bay or
inlet

Water line/label/
Default

Water line large scale/
label/Default

Water line medium
scale/label/Default

Water line small scale/
label/Default

Water area/label/Dam
or weir
Water area/label/Playa
Water area/label/Canal
or ditch

Water area/label/Small
river

Water area/label/Large
river

Water area/label/Small
lake or reservoir

Water area/label/Large
lake or reservoir

Water area/label/Bay
orinlet

Water area/label/Small
island

Water area/label/Large
island

Large scale features

Marine waterbody/label/large

Marine waterbody/label/x large

Marine waterbody/label/2x
large

Indigenous/label/Default

Military/label/Default

Admin1 forest or park/label/
Default

AdminO forest or park/label/
Default

Admin1 area/label/x small
Admin1 area/label/small
Admin1 area/label/medium
Admin1 area/label/large
Admin1 area/label/x large
Admin1 area/label/2x large
City large scale/town small
City large scale/town large

City large scale/small

City small scale/medium
non capital

City small scale/other
capital

City small scale/town
large other capital

City small scale/small
other capital

City small scale/medium
other capital

AdminO0 point/x small
AdminO0 point/small
Admin0 point/medium
AdminO point/large

Admin0 point/x large
City small scale/town
small admin0 capital

City small scale/town
large adminO capital

City small scale/small
admin0 capital

City small scale/medium
adminO capital

City small scale/large
other capital

City small scale/x large
admin2 capital

Continent

Disputed label point/
Island

Disputed label point/
Waterbody

Landform/label/Round
small

Landform/label/Round
medium

Landform/label/Round
large

Landform/label/Round
x large

Landform/label/Round
small

Landform/label/Round
small point

Landform/label/Round
medium

Landform/label/
Oblong medium point

Landform/label/
Oblong large

Landform/label/
Oblong large point

Landform/label/
Oblong x large

Landform/label/
Oblong x large point

Disputed label point/
Admin0

Apply JSON changes to the small scale features first. For large scale features, the default JSON is "text-field":

"{_name_global}" and displays labels in English. If you are changing the map to the local language in each

country where the data supports it, the JSON for these features changes to "text-field": "{_name_local}".
Find and replace "{_name_global}" with "{_name_local}" throughout the JSON file. Listed below are the 47
"id" fields in the streetmap style JSON available for local language in each country where the data supports it.

Other styles may have all or fewer of these features.

For example, "text-field": "{_name_global}" becomes "text-field": "{_name_local}".
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Ferry/label/Ferry
Marine park/label/Default

Marine area/label/Default
Ferry/label/Rail ferry
Railroad/label/Default

Trail or path/label/Default

Road tunnel/label/
Pedestrian

Road tunnel/label/Local
Road tunnel/label/Minor

Road tunnel/label/Major

Road tunnel/label/Highway

Road tunnel/label/Freeway
Motorway

Pedestrian/label/Default
Road/label/Pedestrian

Road/label/Local
Road /label/Minor
Road/label/Major

Road/label/Highway

Road/label/Freeway
Motorway

Cemetery/label/Default

Freight/label/Default

Water and wastewater/
label/Default

Port/label/Default

Industry/label/Default

Government/label/
Default

Finance/label/Default
Emergency/label/Default

Transportation/label/
Default

Beach/label/Default

Golf course/label/Default
Zoo/label/Default
Retail/label/Default

Landmark/label/Default

Openspace or forest/
label/Default

Park or farming/label/
Default

Point of interest/Park

Education/label/
Default

Medical/label/Default
Airport/label/Airport
property

Exit/Default

Point of interest/Bus
station

Point of interest/Rail
station

Point of interest/
General

Admin2 area/label/
small

Admin2 area/label/
large

Neighborhood

Building/label/Default

Other features

There are other features on the map with "text-field": "{_name}" in the JSON file. These features do not
support localization; do not change their JSON code.

Changing the font

It is recommended that you change the fonts to Arial Unicode (bold or regular). Esri Vector Basemap styles can have
different default fonts. For example, the default fonts for streetmap style are Arial Bold, Arial Italic, and Arial Regular.
For the worldtopomap style, the default fonts are Noto Sans Bold, Noto Sans Italic, Noto Serif Regular, and Roboto
Condensed Light Italic. Refer to the font list in the ArcGIS Data Appliance: Esri Vector Basemap Reference Document
(v2) PDF in the Additional resources topic for complete details. Change the fonts to "text-font" : ["Arial
Unicode MS Regular"]. Fonts that are bold by default can be changed to "text-font" : ["Arial Unicode MS
Bold"]. There is no italic font in the Arial Unicode family.
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An example of the streetmap style is shown in Chinese (Simplified).

An example of the navigation style is shown in Spanish.
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Additional JSON edits for Arabic language maps

To ensure that Arabic glyphs appear correctly on the map, either set the text-spacing setting to 0 (zero) or
completely remove the "text-letter-spacing" style attribute from the root.json file. JSON styles may display
this attribute as follows:

"text-letter-spacing” : 0.05,

Or the style may have more complex syntax such as the following:
"text-letter-spacing" : { "stops" : [[4, ©.1], [8, ©.18]] }

Either change these to "text-letter-spacing" : @, or remove the lines completely. Be sure to validate any

root.json before updating the file on your portal.
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Terms of use for ArcGIS Data Appliance: Esri Vector
Basemaps

ArcGIS Data Appliance: Esri Vector Basemaps should only be served up from ArcGIS Server and Portal for ArcGIS
(10.7.1, 10.8, 10.8.1, or 10.9). ArcGIS Data Appliance: Esri Vector Basemaps cannot be transferred to or used with
non-Esri technology.

For more information, see the Master License Agreement on the Esri website.
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Copyright information

Copyright © 1995-2021 Esri. All rights reserved. Published in the United States of America.
The information contained in this document is subject to change without notice.

You may have received Products or Services that include Graph Editor Toolkit, Copyright © 1992-1999 Tom Sawyer
Software, Berkeley, California, All Rights Reserved, and Tom Sawyer Visualization, Ver. 8.0 Copyright © 1992-2009
Tom Sawyer Software, Berkeley, California, All Rights Reserved.

Portions of this computer program are Copyright © 1995-2016 Celartem, Inc., dba Extensis. All rights reserved.

This application supports the ECW data format and ECWP compression protocols. Portions of this computer
program are Copyright © 2007-2015 Intergraph Corporation. All rights reserved. Creating compressed files using
ECW technology is protected by one or more of U.S. Patent No. 6,201,897, No. 6,442,298, and No. 6,633,688.

PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-
identified standards. Consult current PANTONE Color Publications for accurate color. PANTONE® and other
Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2020. Pantone is the copyright owner of color
data and/or software which are licensed to Esri to distribute for use only in combination with the ArcGIS family of
Products. PANTONE Color Data and/or Software shall not be copied onto another disk or into memory unless as
part of the execution of the ArcGIS family of Products.

Third Party OSS-FOSS Acknowledgement Documents

Esri's use of open source software libraries is disclosed in the Third-Party OSS-FOSS Acknowledgement Documents
found at the link below.

Open Source Acknowledgements (https://links.esri.com/open-source-acknowledgments)

ArcGIS Notebooks make use of The FreeType Project, following The FreeType Project License
(https://git.savannah.gnu.org/cgit/freetype/freetype2.git/tree/docs/FTL.TXT).

EXPORT NOTICE

Use of these Materials is subject to U.S. export control laws and regulations, including the U.S. Department of
Commerce Export Administration Regulations (EAR). Diversion of these Materials contrary to U.S. law is prohibited.

US GOVERNMENT CUSTOMER

The Products are commercial items, developed at private expense, provided to Customer under this Master
Agreement. If Customer is a US government entity or US government contractor, Esri licenses or provides
subscriptions to Customer in accordance with this Master Agreement under FAR Subparts 12.211/12.212 or DFARS
Subpart 227.7202. Esri Data and Online Services are licensed or subscribed under the same DFARS Subpart
227.7202 policy as commercial computer software for acquisitions made under DFARS. Products are subject to
restrictions, and this Master Agreement strictly governs Customer's use, modification, performance, reproduction,
release, display, or disclosure of Products. Agreement provisions that are inconsistent with federal law regulation
will not apply. A US government Customer may transfer Software to any of its facilities to which it transfers the
computer(s) on which it has installed such Software. If any court, arbitrator, or board holds that a US government
Customer has greater rights to any portion of the Products under applicable public procurement law, such rights
will extend only to the portions affected. Online Services are FedRAMP Tailored-Low authorized but do not meet
higher security requirements, including those found in DFARS 252.239-7010.
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Esri Trademarks

Esri trademarks and product names mentioned herein are subject to the terms of use found at the following
website: Copyrights and Trademarks (https://links.esri.com/copyright-trademarks).

Licensed Trademarks

Other companies and products or services mentioned herein may be trademarks, service marks, or registered marks
of their respective mark owners.

The Kubernetes ship's wheel logo is a registered trademark of the Linux Foundation.

Trademark Images

Logos of licensed trademarks include the following:

OGC

Making location count.

PANTONE'
Digital Color
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Support

Support for ArcGIS Data Appliance: Esri Vector Basemaps is provided by the Esri Technical Support team.

Use the following contact options:

« United States users—Contact Esri Technical Support using one of the following options. Hours are Monday
through Friday, 9:00 a.m. to 5:00 p.m. (Pacific time), excluding Esri holidays:
= Phone: 888-377-4575

= Email: support@esri.com
= Web page: http://support.esri.com/contact-tech-support

« International users—Support is provided by your local Esri distributor.
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